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* Important Note:  After installing Release 19C, it is imperative that customers 
NOT take the ‘Validate Pool in Exception Status’ option from either the 
GinnieMae Agency Reporting>Security Holder Administration menu or the FHA 
Project Pools Agency Reporting>Security Holder Administration menu.  Doing so 
will cause ALL of the Ginnie Mae pools to go into Exception status.  This option 
can be run after the ‘Update Pools From History and Create Certificate History’ 
option from the GinnieMae menu has been run.  The ‘Validate Pool in Exception 
Status’ program uses this logic for placing a pool in exception status: 
PIRCRT/CRCBAL = PIRPL/PLCBAL minus PIRPLH/PHTP.  Since we changed 
how the GinnieMae pools get updated and we now use field PIRPLH /PHPOS 
(Principal of Securities this monthend) to update the pool balance, this formula 
no longer works because now  PIRCRT/CRCBAL = PIRPL/PLCBAL.  We have 
changed the program for GinnieMae so it no longer subtracts PIRPLH/PHTP 
which will work after the ‘Update Pools From History and Create Certificate 
History’ option from the GinnieMae menu has been run.  We did not change the 
program for the FHA Project Pools.                     
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TIMETABLE 
 

Below is the timetable and sequence of events for boarding and reporting on 
Ginnie Mae loans.  Dates in the timetable use Reporting Cycle of 09/2008 as 
the example.  The tasks need to be performed in this order to avoid Pools from 
going into ‘Exception’ status.  Timetable updated based on APM 11-15 dated 
September 30, 2011. 

 
Timeframe: Description of Task: Dates for 

09/2008: 

Prior to boarding first Ginnie 
Mae Loan 

Add new Investor Vendor – One Time Only  

Any time before the 15th of the 
1st Reporting Cycle 

Add Security Holder record for Book Entry Certificates – 
One Time Only; Located on Page 34 

 

  Confirm Dayend Jobstream – One Time Only 09/1/2008 – 
09/30/2008 

New Ginnie Mae loan passed 
in Strategy 

Print and Review MB616 – Exception Report – Update Pool 
Records with Certificate Information (not created in 
Monthend; generated in dayend that new GNMA loan is 
passed); Also, enter Maturity Date in Pool Record. 

Dayend reports 
for day loan is 
passed 

Last Day/Weekend of the 
Month 

Run Monthend 09/30/2008 

After Monthend; prior to any 
reporting 

Print and Review MB634C – MBS Balance Reconciliation 
Report (created in Monthend) 
 

10/1/2008 

After Monthend Start Ginnie Mae Reporting Process 10/1/2008 

After Monthend; Due no later 
than 2nd Business Day 

Create RPB Call-In Report (Security Balance and Guaranty 
Fee Amounts) 

10/1/2008 -  
10/2/2008 

  Create RPB File, Print RPB Listing, and Call-In Balances 10/1/2008 -  
10/2/2008 

After Monthend; prior to 
submitting RFS  

Perform any necessary adjustments to Pool History (11710-
A) 

10/1/2008 -  
10/2/2008 

After Monthend; Due no later 
than 4th Business Day 

Corrections to RPB Balance Call In and RFS Critical 
Exceptions must be Cleared 

10/1/2008 – 
10/6/2008 

 Update ‘# of Certificates’ in new Pool records 10/1/2008 -  
10/6/2008 

  Add newly issued Certificates for new Pools 10/1/2008 -  
10/6/2008 

  Add newly issued Certificate(s) for previously issued Pools; 
Surrender old Certificate(s) 

10/1/2008 -  
10/6/2008 

 Update ‘# of Certificates’ in previously issued Pools if 
transferring 1 to multiples 

10/1/2008 -  
10/6/2008 

 Verify all Pools with a Balance are not in ‘Exception’ Status 10/1/2008 -  
10/6/2008 

 Create and Print 11710-D, if required. 10/1/2008 -  
10/6/2008 

 Print 11710-A reports, if required. 10/1/2008 -  
10/6/2008 

After Monthend; Due no later 
than 2nd Business Day 

RFS Reporting.  Even though the Due Dates of some of 
the previous activities are after the 2nd Business Day 
they should be completed prior to creating the RFS file. 

10/1/2008 -  
10/2/2008 

Due no later than 10th 
Business Day 

RFS High, Medium, and Low Exceptions must be Corrected. 10/1/2008 – 
10/14/2008 

Due no later than 10th 
Business Day 

11710-A and 11710-D Corrections 10/1/2008 – 
10/14/2008 

Prior to P&I Remittance; Due 
on 15th 

Update Pools from History – ONLY RUN ONCE 10/7/2008 – 
10/15/2008 

 Perform Pool to Security Reconciliation  

 Create Certificate History Records for Current 
Reporting Month - ONLY RUN ONCE 

 

 Review Certificate History Exception Report  

 Create and Print Remittance Advices (11714)  

 Create 11714 Electronic File, if required.  

 Run Preliminary Check/Wire Report and verify amounts  

 Create Check/Wire Records  

Day of P&I Remittance; Due on 
the 15th 

Release Custodial Processing Record to Debit P&I 
Remittance from Investor Vendor 

10/15/2008 

After completing previous 
reporting cycle and last day of 

Pass Ginnie Mae loans into Strategy for 1st Reporting Cycle 10/15/2008 – 
10/31/2008 
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the month for the 1st Reporting 
Cycle  

New Ginnie Mae loans should not be passed into Production until after that month’s 
Ginnie Mae Reporting has been completed.  As soon as a new Ginnie Mae loan is 
passed the Dayend will automatically create the Pool Record.  Need to enter the Pool 
Maturity Date so it prints on the Security Holder (Certificate) Register.  
 
Once the Pool Record is added the new Pool will be included on the Ginnie Mae 
reports and in the RFS files.  Therefore, the report totals will include data for a Pool 
which is not due to report until the following month.  I.e.  Initial Reporting Month for new 
Pool is October 2008.  Therefore, the new loan should not be passed into Production 
until all the Reporting is completed for September 2008; after October 15

th
 before 

October 31
st
. 

 

The MB616 report is not generated at Monthend; it is a daily report.  A 
Pool would only display on the report during the dayend that the loan is 
passed.  Therefore, a step to review this report should be added to 
customer’s internal procedures for passing a New Ginnie Mae Loan in 
Strategy.  The dayend report should be reviewed every time a new 
Ginnie Mae loan is passed 

 

1. INVESTOR VENDOR SETUP 
 
Prior to setting up the first Ginnie Mae loan on Strategy the applicable Investor 
Vendor record(s) must be created.  Strategy allows multiple Ginnie Mae 
Investors to be setup.  It may be helpful to use a different Investor Vendor # for 
the Ginnie Mae Construction loans.  The Strategy ‘Program ID’ for Ginnie Mae is 
“G1”.  Strategy uses the ‘Program ID’ to determine what type of reporting is 
required. 
 
Investor Vendor records are accessed as follows:  
Tools>Maintenance>Vendor Maintenance (the Investor Vendor records will 
most likely by setup by a system administrator): 
 

 
 
Examples:  Investors #024 600, 601, and 602 haves been setup as the Ginnie 
Mae Investors and the significance of various critical fields contained in the 
vendor record are noted below.  Investors 600 and 601 are tied to the same 
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Seller/Servicer (Issuer).  The values entered in the setup will control the 
Reporting and Accounting functions performed by Strategy. 
 
There are multiple screens to the Investor Vendor record and most of them are 
accessed from Right>Mouse options.  This is the initial screen: 
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 The ‘Program ID’ must = “G1” 

 Enter Issuer Name & Address information in Address Lines 1-4; prints on 
11710A, 11710E, and 11710D reports.  If there are multiple investors for 
the same Seller/Servicer # (Issuer), recommend setting this data up to be 
the same in all vendor records. 

 ‘Seller/Servicer #’ must be entered in the 1st position followed by zeroes in 
order to populate your number in the various files and reports. 

 Enter “Issuer RPB Report ID #” so it prints on the 11710D Summary 
report. 

o This should also be file maintained in all existing G1 Investor 
Vendor records. 

 ‘Internal Investor’ must = “N” 
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Right Mouse Option – Bank Accounts: 
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This is where the user sets up the various Clearing, Custodial and Corporate 
bank accounts.  The Ginnie Mae Investor has been setup so that all borrower 
payments are deposited into a ‘Deposit Clearing’ account and then the 
appropriate funds are debited from the ‘Deposit Clearing’ account and credited to 
the Ginnie Mae P&I and T&I, and Corporate Cash accounts.   
 
If the ‘Custodial Suspense’ DDA is the same as the ‘Custodial P&I’ DDA in the 
Investor Vendor record then the Suspense Balance (Escrow 6) as of cutoff will be 
reported in the pool’s 11710A, Section 5B3 – Other. 
 
If the ‘Custodial Suspense’ DDA is the same as the ‘Custodial Escrow’ DDA in 
the Investor Vendor record then the Suspense Balance (Escrow 6) as of cutoff 
will be reported in the pool’s 11710A, Section 5B1 – Tax and Insurance Funds. 
 
Right Mouse Option – Remittance Information: 
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 This screen sets up the Cutoff and Remittance parameters for the 

Investor.  Both the Cutoff and Remittance Dates are setup as Once a 
Month.   

 

 Hold Posting = “Y” means Strategy will not automatically debit the Investor 
principal and interest funds.  This allows the user to review the Strategy 
created Investor Custodial Processing entries prior to releasing and 
debiting the funds from the P&I account. 

 

 In order for the Net P&I to be deposited into the Ginnie Mae P&I Custodial 
account you must set ‘Dep Gross Cust’ and ‘Remit Gross P&I’ = “N” and 
‘Remit Net P&I’ = “Y”.  By doing this the Guaranty and Servicing Fee 
amounts collected will be deposited into the identified Corporate Cash 
account and only the Net P&I is remitted.  Otherwise, set ‘Dep Gross Cust’ 
= “Y” (servicing and guaranty fees will be deposited into P&I Custodial 
DDA). 

 

 ‘Percent Due Servicer’:  enter the percentage of servicing fees collected 
that will be retained by Servicer.  Remainder will be remitted to Investor(s). 
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Right Mouse Option –Accounting Information: 
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After the Ginnie Mae Investor Vendor record is setup the loans can be boarded 
and passed. 
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2. CRITICAL GINNIE MAE LOAN SETUP INFORMATION 
 

There are critical fields and loan setup criteria unique to Ginnie Mae loans.   
These key data points are referenced in this section.  This data resides in the 
following files:  Master File, System Information, Loan Collateral, Property, Other 
Escrow for MIP & Reserves, Investor Master File, RFS Files, and System 
Control.   
 
A few screen shots from the ‘Loan Entry’ module have been included to 
reference some of the differences between accessing information from ‘Loan 
Entry’ versus a loan in Production.   
 
If the user is boarding or entering a new loan manually into Strategy the module 
is accessed as follows:  File>Module List>Loan Entry: 
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Associated Name Files  
 
The Primary and Additional Borrowers’ information is setup in the Loan 
Administration module which is accessed as follows:  File>Module List>Loan 
Administration.  Go to the ‘Customer Info’ tab. 
 

 
The ‘Primary Borrower’ record information is captured and populated in the 
Ginnie Mae Sensitive Loan Record (File - PSENSLOAN) in the ‘First Name 1’ 
and ‘Last Name 1’ fields.  The RFS file contains the following fields: Tax ID#/SSN 
#, First and Last Name or Company Name. 
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A new ‘Role Type’ of “GMAB” has been created to identify any Additional 
Borrower records that should be reported in the Ginnie Mae RFS Sensitive 
Record.  ‘Role Type’ resides in the Strategy Maintained System Information 
Table Id – “R5”. 
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If there are Additional Borrower Records that need to be included in the Ginnie 
Mae RFS Sensitive Record they need to be added with the GNMA RFS 
Additional Borrower Role Type (“GMAB”).  Right mouse click on the main screen 
and go to ‘Roles’.  The ‘Associated Name Roles’ information is stored in file – 
PROLELOAN.  Associate the ‘Role Type’ with the Additional Borrower Record. 
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The Additional Borrower information is captured and populated in the Ginnie Mae 
Sensitive Loan Record (PSENSLOAN) in the ‘First Name 2 - 5’ and ‘Last Name 2 
- 5’ fields.  The RFS file contains the following fields: Tax ID#/SSN #, First and 
Last Name or Company Name. 
 
 
Loan Master File – PMASTR 
 
The first file containing pertinent Ginnie Mae loan information is the Loan Master 
File, Strategy File – PMASTR.  If the user is in Loan Entry they would access the 
Master File as follows:  Tools>Loan Entry Modules>Loan Administration.  Click 
on the ‘Master Info’ tab. 
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To access the Master File on a loan that is in Production:   File>Module 
List>Loan Administration.  The module opens up on the ‘Customer Info’ tab.  Go 
to ‘Master Info’. 
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Important Master File Fields for Ginnie Mae loans: 
 
Payment/Billing: 

 

 Since HUD does not accept application of partial payments, ‘Allow Partial 
Payments’ should be “N”. 

 The monthly MIP payment should be entered in ‘Mip FHA Payment’. 
 ‘Simple Interest’ should be = “N” to set loan up as scheduled amortizing.  

Setting the flag = “N” will treat the loan as scheduled amortizing and the 
interest will accrue on the Scheduled Principal Balance; which will 
amortize whether or not the payment has been made. 
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Balances/Processing: 
 

 
 The Mip Fha Balance is reflected in this field.  If user is boarding a new 

loan where an amount for MIP was collected at closing they would reflect 
that amount in this field.  In Loan Entry the field is labeled ‘Pmi/fha 
Collected’ (see below).  In Production the field is labeled ‘Pmi/fha Balance’ 
(see above). 
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Contract: 
 

 

 ‘Original Loan to Value Ratio %’ is used to populate the ‘Loan To Value’ 
field in the Ginnie Mae RFS - Various Loan Record file (PVARLOAN).  
The value will automatically get populated in the green screen once the 
customer selects an account that Various Loan Records should be 
created for.  Since Issuers should only use the Various Loan Record to 
make changes to incorrect or incomplete data originally reported on the 
HUD Form 11706 – Schedule of Pooled Mortgages, at pool issuance, the 
LTV field on the RFS green screen will need to be blanked out if 
there’s no change to this amount. 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 27 of 159 

 
Esc/LateChg/Default: 
 

 
 In order for the MIP payments to be billed and collected on the loan 

‘Collect Other Escrow’ must = “Y”. 
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Reporting: 
 

 
 Loan Type = “F” for FHA (gets populated in RFS Loan Record File - 

PIRLL) 

 Loan Classification = “GN” for Ginnie Mae Loans.  This is a User Defined 
field. 

 Investor Sold Loan = “Y” (Ginnie Mae is an external Investor) 

 MBS Loan = “Y” 
 

Loan Type (System Information Table 63) 

 
Ginnie Mae has specific codes to define Loan Type.  The codes are FHA, FH1, 
FMF, RHS, RMF, PIH, VAG and VAV.  The Loan record for GNMA (PIRLL) must 
contain one of these values in the Loan Type field. 
 
The Loan Type field in Strategy is a User Defined System Info table (PINFO table 
63).  This System Information table corresponds to the Loan Type in the Master 
record and is displayed in Loan Administration.  The “Short Description” in the 
System Information record will be used to map the Strategy Loan Type to the 
Ginnie Mae Loan Type. 
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When the Ginnie Mae files are created, Strategy will take the Loan Type from the 
Master File record and retrieve the corresponding Ginnie Mae Loan Type from 
the short description in the Loan Type System Information record. 
 
You must update the short description of the Ginnie Mae Loan Types in the 
System Information file with the appropriate Ginnie Mae Loan Type (FHA, 
FH1, FMF, RHS, RMF, PIH, VAG or VAV).   
 
Verify that the loans you report to Ginnie Mae have the correct Loan Type in the 
Master record and that the short descriptions for these Loan Types contain the 
required Ginnie Mae value. 
 
Instructions: 
 
Access the Loan Type System Information table: 
 
StrategyCS > Tools > Maintenance > System Information > Sys Info Maint 
 
Select Master Code “63” – ‘Loan Type’ 
Update the Short Description where appropriate with the Ginnie Mae Loan Type: 
FHA, FH1, FMF, RHS, RMF, PIH, VAG or VAV. 
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 Loan Collateral/Property Files – PCCOLLCRE & PPROP 

 
The property information is setup in the Asset Management module which is 
accessed as follows:  File>Module List>Asset Management.  Go to the ‘Property’ 
tab. 
 

 
Values in the following fields for Property Sequence #001 are populated in 
the Ginnie Mae RFS Sensitive Loan Records when they are selected to be 
submitted in the RFS Reporting File (PGNMARFS):  Street #1, Street Name 
#1, Village (Village will populate as the ‘City’ in the file if not blank.  If blank 
will use PINFO/SIFFUL table “32” using PQTOWN to retrieve PINFO record), 
State, and Zip.  Issuers only submit the “Sensitive” Loan record(s) to make 
changes to incorrect or incomplete data.  
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Other Escrow File (MIP) – POESC 
 
Important Escrow File Fields for Ginnie Mae loans: 
 
The MIP information is setup in the Insurance module which is accessed as 
follows:  File>Module List>Escrow Processing.  Go to the ‘Insurance’ tab. 
 
When adding a new MIP record (click on the tiffany box to ‘Add’) you need to 
select ‘MIP FHA (4)’. 
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Existing MIP record: 

 
 The ‘Exp/FHA Due Date’ is the date that the next MIP premium is due. 

 The ‘Policy #/FHA Case#’ is the HUD project id.  The RFS Loan Record 
(PIRLL) does not use this field to populate the Case Number in the 
reporting file; it gets populated with the value contained in the ‘Investor 
Loan #’ field from the Investor Master File (PIMST.IMIL#) 
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In Production, the MIP Disbursement Information is accessed by performing a 
right mouse option off the initial screen and selecting:  Insurance>Disbursement 
Info: 

 
 

 If the MIP payments are being collected and remitted the ‘Billing Status’ 
must = “2”. 

 The ‘Next Remit Date’ is used to create the system disbursement.  You 
can perform a bulk disbursement based on the ‘Next Remit Date’ and the 
‘Insurance Agent’. 

 The ‘Premium Amount’ reflects the next MIP payment amount due. 

 The ‘Payment Amount’ reflects the current MIP amount being collected 
from the Borrower. 

 Since the MIP is paid annually the ‘# Months to Remit’ and ‘Disbursement 
Frequency’ = “12”. 
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Other Escrow File (Replacement Reserve) – POESC 
 
The Replacement Reserve information is setup in the Insurance module which is 
accessed as follows:  File>Module List>Escrow Processing.  Go to the 
‘Reserves’ tab. 
 
Click on the tiffany box to ‘Add’ a Reserve Record:  
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Existing Reserve Record: 

 
 

 ‘Replacement Reserve Balance’ is a field included in the Ginnie Mae 
Pool Record (File – PIRPLH) and the RFS Reporting File (PGNMARFS).  
Strategy calculates this balance by adding up all the balances for 
each Reserve Type on the loan which is setup with a “G” in the VERY 
last position of the ‘Full Description’ field in the PINFO Table “2V”.  
See details below. 

 The RFS file can only report one Replacement Reserve DDA# and 
Bank ID.  When creating the RFS file the program will retrieve these 
values from the first Reserve Balance record (File – PRBL) where all 
of the following are true: 

o The PRBL Escrow # = “3” 
o A POESC record exists for the Loan with the System Escrow 

# = “3” and the Sequence # is = to the PRBL_RBRSV value 
and the Record Delete Code is blank.  

o A PINFO record exists with Table ID “2V” and Code = 
POESC_SOTYPE and “G” is in the last position of the ‘Full 
Description’ field SIFFUL. 

When all the above is true that RBDDA value and RBBANK value 
gets populated in the RFS file. 
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Reserve Type (System Information Table 2V) 

 
Instructions: 
Access the ‘Reserve Type’ System Information table: 
 
StrategyCS > Tools > Maintenance > System Information > Sys Info Maint 

 Select Master Code “2V” Reserve Type 

 Must enter the letter “G” in the very last position of the Full Description 
field for any Reserve Type that should be included in the Replacement 
Reserve Balance reported to Ginnie Mae. 

 

 
 

 If necessary, the Replacement Reserve Balance can be file maintained in 
the Ginnie Mae RFS Reporting File by using the Ginnie Mae Menu Option 
2 – ‘Ginnie Mae Additional Pool History File Maintenance’.   
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 File Maintenance details can be found under Section 21 – ‘RFS Reporting’ 
in this document.   

 
Investor Master File – PIMST 
 
Important Investor Master Fields for Ginnie Mae loans: 
 
The Investor module is accessed as follows:  File>Module List>Investor 
Processing. 
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In Production, the Investor Master screens appear as follows: 

 
 

 ‘Group/Pool #’ is the Ginnie Mae Pool number.  Enter the 2-CH alpha 
code at the end (I.e.:  Group/Pool:  245788PL).   

 ‘Investor Loan #’ must contain the FHA Case Number.  The value in 
this field gets populated in the Ginnie Mae RFS Loan Record (PIRLL) 
which is included in the monthly reporting file.  The FHA Location Code 
must be entered in the first three positions; followed by the Serial Number 
in the next five positions.  In accordance with the RFS File Layout, MFS is 
filling the first seven positions with leading zeroes.  The RFS field length is 
15 so the MFS file will only retrieve the first 8-CH entered in the ‘Investor 
Loan #’ field.  I.e.:  ‘12147851REF’ will be populated as 
‘000000012147851’ in the RFS Loan Record. 

 ‘Participation %’ should = “100.000000”   

 ‘Current Principal Balance’ should equal the current loan balance since 
the Ginnie Mae Investor owns 100% of the loan.  If you are boarding a 
new loan where the original Ginnie Mae was issued on an amortized loan 
balance you will still key in the cents portion of the balance here (even 
though pools are issued in whole dollar amounts).  

 ‘Principal Purchased’ for newly issued Pools represents the original 
balance of the Ginnie Mae pool.  This should equal the ‘Total Subscribed’ 
amount on the 1701 11705 form (no cents).  Strategy uses this balance 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 40 of 159 

to populate both the ‘Original Pool Balance’ and the ‘Current Pool 
Balance’ in the Pool Record.   

 ‘Net Yield Method’ = “X” for fixed loans. 

 ‘Net Yield %’ is the Pass Thru Interest Rate for the Security Holders. 

 ‘Guarantee Fee Method’ = “R” 

 ‘Guarantee Fee %’ is the rate used to calculate the monthly guaranty fee 
due for each pool. 

 ‘Next Cutoff Date’ and ‘Last Cutoff Date’ should be the last day of the 
month. ‘Settlement Date’, ‘Interest Purchased Date’ and ‘Balance Date’ 
are equal to the initial issue date of the Ginnie Mae security.  It should 
always be the 1st of the month. 

 ‘Settlement Date’, ‘Interest Purchased Date’, and ‘Balance Date’ should 
equal the Pool Issue Date.  The ‘Settlement Date’ is used to populate the 
Pool Issue Date in the pool record that is created in the 1st dayend run 
after passing the loan.  This date will be used to identify the first reporting 
cycle for the loan and comes into play when determining what pool history 
record will need to reflect the adjustment amount on the 11710A for the 
over/under collatarlized pools.  

 
Report/Balances: 
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 The information under ‘Last Report’ gets populated in ‘Section 3 – 
Principal Amount of Securities’ of the 11710-A report.  For this pool, 
“3,991,037.10” was the balance populated in ‘Section 3D –Principal of 
Securities this Monthend’ in the 09/2008 Pool History record (11710-A).  
When a new loan is entered this should equal the ‘Total Subscribed’ 
amount on the 1701 11705 form (no cents).  Strategy uses this 
Balance when creating the new pool record in Dayend after the loan 
is passed into Production.  Populated as ‘Current Balance’ in Pool 
Record. 

 The information under ‘Previous Report’ gets populated in ‘Section 1 – 
Pool Administration’ of the 11710-A report.  For this pool, “3,994,039.03” 
was the balance populated in ‘Section 1D – Balances this Monthend’ in 
the 09/2008 Pool History record (11710-A).  When a new loan is entered 
this should equal the ‘Total Subscribed’ amount on the 1701 11705 
form (no cents) and should be the same as the amount entered under 
‘Last Report’.   

 
The ‘Settlement Date’ reflects the first reporting cycle for the loan and 
comes into play when determining what pool history record will need to 
reflect the adjustment amount on the 11710A for the over/under 
collatarlized pools. A pool is over/under collateralized if Investor Master 
‘Principal Current Balance’ is not equal to ‘Principal Balance Last Report’.  
The first 11710A will pick up the necessary adjustment amount to bring 
the Pool and Loan in balance.  Amount of adjustment reported in Section 
1C-Pool Principal Other will be equal to ‘Principal Current Balance’ minus 
‘Principal Balance Last Report’.  The reverse amount will be reported in 
Section 2D and will flow through to the Principal Adjustment field in 
Certificate History record(s).  
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 For the scenario described below, the ‘P&I Payment’ information under 
‘Last Report’ gets populated in ‘Section 1C – Fixed Installment Control 
(Other)’ of the 11710-A report.   
 
I.e.  Loan is closed 5/4/2015.  Loan is passed in Strategy between 
5/4/2015 – 5/31/2015.  Settlement Date and First Reporting Cycle = 
5/1/2015.  First payment to Principal is due 7/1/2015. 
 
The ‘P&I Constant’ in master file in new loan setup would equal the 
7/1/2015 principal and interest payment due. 
 
In order to report the P&I Constant due 7/1/2015 in ‘Section 1C – Fixed 
Installment Control (Other)’ of the 11710-A report, this amount must also 
be entered in the Investor Master ‘P&I Payment’ information under ‘Last 
Report’.   
 
Any pending change records setup to switch the GinnieMae Loan 
Payment Type to Regular Amortizing will need to be setup with an 
Effective Date no later than the last day of the month.  This ensures that 
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the 11710A will pick up the Fixed Installment Control – Other amounts in 
the correct reporting period.   
 

 The ‘P&I Payment’ information under ‘Previous Report’ gets populated in 
‘Section 1A – Fixed Installment Control (balance from last report)’ of the 
11710-A report.  If the pool is not reporting any Principal for the initial 
reporting period this amount should be 0.00.   
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Remit/Processing: 
 

 
 

 Since the remittance to Ginnie Mae Security Holders is monthly, ‘Daily 
Remit Required’ = “N”. 

 Ginnie Mae loans have to remit on a scheduled/scheduled basis so 
‘Scheduled Interest’ and ‘Scheduled Principal’ = “Y”. 

 In order to get the Dayend Investor reports to group the Ginnie Mae loans 
together in the same report, ‘Group Reporting’ = “Y”. 

 ‘Int Adj Method for Curtailments’ = “FNMA/GNMA” 
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Ginnie Mae Unique Loan Key 
 
The Unique Loan Keys need to be setup for each loan prior to running the 
1st Ginnie Mae Monthend Cutoff in order for the Ids to be populated in the 
RFS Reporting File (PGNMARFS).  The change must be made prior to 
running the monthend cutoff or it will be reported as all zeroes.  The unique 
IDs should be setup as part of passing the new loans into Production. 
 
 
Overview: 
 
Ginnie Mae has provided a Unique Loan Key to identify loans reported.  The 
Unique Loan Keys must be added to the new Additional Information file 
(PIMSTADL) in Strategy.  There are two methods to do this: 
 

1. The Loan Keys can be added manually (loan by loan) to the Additional 
Information file.  This is done via the GNMA Menu, Option 1 GNMA Loan 
Key Maintenance.   

 
2. Upon implementing the RFS Reporting, Ginnie Mae sent each Issuer a 

CSV file (comma delimited) containing the unique Loan Ids.  McCracken 
Financial Solutions wrote a program that will update the Ginnie Mae Loan 
Keys in the Additional Information file (PIMSTADL) file from the file sent by 
Ginnie Mae.  If you want to use this method, please contact your 
Customer Support representative. 

 
Instructions for adding manually: 
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All of the Ginnie Mae RFS reporting screens are accessed via Green Screen.  
From the ‘Master Menu’ select option “5”. 

 
 

 
If you leave the ‘Account Number’ field blank it will display all loans tied to that 
Investor Number. 
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Foreclosure Hold Code – System Control 
 
Overview: 
 
If a loan should be reported to Ginnie Mae as “In Foreclosure”, one of the three 
Hold Codes for the Loan must be the “Foreclosure Hold Code” that is specified in 
the System Control Servicing record. 
 
Instructions 
 
Step 1: 
Verify that the correct “Foreclosure Hold Code” has been specified in the 
Servicing window in System Control. 
 
StrategyCS > Tools > Maintenance > System Control > Section:  Servicing > 
Processing Activities 
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Step 2: 
Verify that any loan to be reported to Ginnie Mae as “In Foreclosure” contains the 
Foreclosure hold code. 
 
StrategyCS > Loan Administration > Master Information Tab > 
Balances/Processing. 
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The ‘In Foreclosure Flag’ field contained in the Ginnie Mae RFS Loan Record 
(PIRLL) will contain value “Y” if any of the three ‘Hold Code’ fields in the Master 
File contain the applicable Foreclosure Code setup in the System Control File 
(set flag to “Y” if:  PMASTR/CMHC1, CMHC2, or CMHC3 = 
PSYSCSRV/S6FHC.)   
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3. CONFIRM DAYEND/MONTHEND JOBSTREAM 
 

Confirm these jobs are running in the Dayend Jobstream:  CMB616, CMB621A, 
CMB620, and CMB621.   
 

4. PROCESS NON-PAYOFF POOL LIQUIDATIONS 
 
In order for Strategy to liquidate a pool on the 11710A and automatically produce 
a 11710E form due to Foreclosure or Repurchase, the Investor Master Record 
Status Code must be file maintained prior to running the Cutoff.  If the Record 
Status Code is changed to “F” or “R” prior to the Monthend Cutoff is run, these 
activities will automatically occur. 
 
For “F” liquidations, the Payoff/Repurchase Date will be populated with the date 
that the file maintenance occurred.  For “R” liquidations, the Payoff/Repurchase 
Date will be populated with the cutoff date.  This date will also be the “Date 
Removed” on the 11710E. 
 
A pool will not automatically liquidate for Assignments, Record Status Code “A”.  
Since the timing of liquidating the pool is subjective, a liquidation record would 
manually be added from the GinnieMae Agency Reporting menu.  Once the 
record is added, the 11710E form can be genereated.  The 11710A record would 
also need to be manually updated to reflect the liquidation. 
 
On pools where the Investor Master Record Status Code has been file 
maintained to “F” or “A” prior to the Monthend Cutoff being run, the pools will be 
reported in the ‘Foreclosure’ box on the 11710A and 11710D. 
 
4.5. RUN MONTHEND  
 

These are the reports that are generated by the Monthend cutoff and are used 
for the Ginnie Mae Reporting Process: 
 

 MB634C – MBS Balance Reconciliation Report 

 MB616 – Exception Report – Update Pool Records with 
Certificate Information (It’s a Daily report - the Pool only displays on this 

report during the dayend that the loan is passed.) 
 
5.6. PRINT AND REVIEW MB634C  
 

The MB634C report does a forecast for the next reporting month to confirm 
the loan and the pool are in sync using the following calculations:  current 
loan balance (as of 09/30/2008), (+/-) adjustments for any delinquent or prepaid 
principal, and (-) the scheduled principal payment due 10/1/2008.  This report will 
show any differences between the anticipated Pool/Security Balance and the 
amortized Loan Balance. 
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These are the remaining fields on the MB634C report.  “Differences” noted 
on the report may require user to maintain the Investor Master Record.  For 
the over/under collateralized pools the necessary adjustment to bring the 
loan and pool in sync will automatically be picked up in the Pool History 
record(s).   The procedures for maintaining the Pool History Records are 
referenced later on in this document. 
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This report shows a difference on the new pool that was setup, alerting the user 
that there are some setup issues between the Loan and the Investor 
Master/Pool. 
 

This requires the user to file maintain the ‘Last Report Balance’ in the 
Investor Master File to equal the “Adjusted Actual Balance” amount on the 
MB634C report (equals the Security Balance; for Reporting Period 09/2008 
this would be the Scheduled Balance after the 10/2008 principal payment).  
Also, file maintenance is required to the 11710-A or Pool History Record.  Details 
of these changes are noted in Section 11 of this document.  
 
When a new Pool is issued on an amortized loan the ‘Principal Purchased’, 
‘Principal Balance Last Report’, and ‘Principal Balance Previous Report’ in the 
Investor Master File is setup without the cents (equals original issue amount of 
the Ginnie Mae Pool).  The ‘Current Principal Balance’ in Investor Master is setup 
with the amortized loan balance.  Therefore, these loans would reflect a 
“Difference” on the MB634C Report (initial Reporting Monthly only); pool is 
over/under collateralized.   
 
By setting it up this way the Pool will display a “Difference” on the Monthend 
MB634C report alerting the user to file maintain the ‘Last Report Balance’ in the 
Investor Master File to equal the “Adjusted Actual Balance” amount on the 
MB634C report.  adjust the principal amount that is passed through to security 
holders in order to bring the Pool and Loan back in sync. 
 
The report will also show a “Difference” on those pools that have been liquidated 
due to the Investor Master Record Status Code being file maintained to “F” for 
Foreclosure or “R” for Repurchase.  In these cases, the Pool is liquidated and 
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brought down to a 0.00 balance but the Loan has not been paid off resulting in a 
“Difference” on the report. 
  

6.7. PRINT AND REVIEW MB616  
 

This report is not generated at Monthend; it is a daily report.  A Pool would only 
display on the report during the dayend that the loan is passed.  Therefore, a 
step to review this report should be added to customer’s internal procedures for 
passing a New GinnieMae Loan in Strategy.  The dayend report should be 
reviewed every time a new GinnieMae loan is passed. 
  
The MB616 report shows if there are pools are in exception status: 
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Active Pools that display on the Exception Report need to be reviewed for setup 
issues.  The ‘Certificate Record’ for this Pool had not been created so it was 
populated on the Exception Report.   
 

8. PRINT AND REVIEW LIQUIDATION REPORT MB654A_1 & MB654A_2 
 

These reports will still generate as part of the cutoff but the GinnieMae reports 
are no longer under MB634A.  The GinnieMae reports are now MB654A_1 and 
MB654A_2.  In addition to loans that have been paid off, loans that have 
liquidated due to the Investor Master Record Status Code being changed to “F” 
or “R” prior to cutoff will also be reflected on the reports. 
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7.9. START REPORTING PROCESS 
 
 

The Ginnie Mae reporting is accessed from the Investor module.  The 
navigation is as follows:  File>Module List> Investor Processing.  After the 
Investor module opens go to:  Tools>Agency Reporting>Ginnie Mae.  The 
majority of the Ginnie Mae Reporting Process is done under the ‘Pools’ 
menu not ‘Security Holder Administration’. 
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8.10. CREATE RPB CALL-IN REPORT  
 
 

‘Create RPB Call-In Report’ (Creates report MB617A with the new Security 
Balance and Guaranty Fee amounts for the new Reporting Month): 
 

 
 

Enter the applicable ‘Reporting Date’ and click on [Run] to create the report in 
your spool file. 
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The ‘Security Total’ represents the Total Pool Security Balances for the Current 
Reporting Month.  The ‘Current Total’ for $1,731.03 represents the Total 
Guaranty Fee for the Current Reporting Month. 
 
This report will be used later on to reconcile to the 11710-D: 
 

 Compare the Guaranty Fee Total on the RPB Call-In Report 
MB617A to the total on the 11710-D. 

 Compare the Security Balance Total on the RPB Call-In Report 
MB617A to the total on the 11710-D. 

 Compare the Pool Principal Balance on RPB Call-In Report 
MB617A (fourth column on this report - $15,980,307.53) to the total 
on the 11710-D. 
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9.11. CREATE RPB FILE 
 

‘Create RPB File’ (Creates Strategy File - PRPBS and Report GR650V): 
 

 
Enter the Reporting Date and Click on [Run] to create the file. 
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The PRBS file used to be transmitted to NDC.  Verify whether or not Pools in 
‘Exception’ Status will be excluded from the PRPBS file.   
 

 
In addition to creating the PRPBS file, this menu option also creates the 
RPBLISTING report in your spool file. 
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10.12.  EDIT 11710-A, POOL HISTORY RECORDS  
 

There are certain instances which require the user to file maintain the information 
in the Pool History Record (11710-A).  These records should always be 
reviewed on Liquidated Pools, Pools that displayed a ‘Difference’ on the 
Monthend MB634C Report, and Newly Issued Pools.  Examples of 
adjustments for New Pools are: 
 

 Clear the odd days’ interest amount collected at closing from Section 
1-A Pool Interest. 

 Make adjustments for pools issued on amortized loans.  See details 
below. 

 Zero out the Fixed Installment Control amounts in Section 1-A and 1-
D for permanent Pools issued on non-amortizing loans. 

 
Changes made to the 11710-A records will be picked up in the Ginnie Mae RFS 
Reporting File (File – PGNMARFS) as long as the file is created or re-created 
after the changes have been made.  Details on the RFS Reporting are located in 
Section 21 of this document. 
 
Select ‘Pool History’ option from menu if any edits need to be made to the 11710-
A report.  In Strategy the records are contained in File - PIRPLH.   
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As previously mentioned in this document, file maintenance will no longer be 
required on those new Pools that were issued on an Amortized Loan Balance 
(over/under collateralized pool).  In addition to previously maintaining the “Last 
Report Balance” in the Investor Master Record to equal the ‘Adjusted Actual 
Balance’ from MB634C report the following changes need to be made to thethe 
cutoff program will create the initial Pool History Record (11710-A) as follows: 
 

 1-A (Pool Principal):  Balance should will equal the original amount of the 
GNMA security.  Need to wipe out the cents. 

 1-B (1) (Pool Interest and Pool Principal):  These fields should be blank. 
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 1-C (Other):  Enter Equals the cents of the amortized loan balance. 

 1-D (Pool Principal):  Enter Equals the amortized loan balance in this field 
(should will equal Section 1-A + Section 1-C). 

 2-D (Other):  Enter Equals the cents of the amortized loan balance as a 
negative number.  Assumes the Pool Amount < Amortized Loan Balance 
(Loan Balance = $2,500,000.56; Pool Issued for $2,500,000.00). 

 2-E (Total Principal):  Automatically calculates new amount (Section 2A – 
Section 2D). 

 2-G (Total Cash):  Automatically calculates new distribution amount 
(Section 2E + Section 2F). 

 3-A (Principal):  Amount should be the same as Section 1-A (Pool 
Principal). 

 3-B (Principal):  Amount should be the same as Section 2-E. 

 3-D (Securities):  Automatically calculates new amount (Section 3A – 
Section 3B). 

 
It may also be necessary to make tThe principal adjustments entered in 
Section 2-D will automatically flow through to the corresponding Certificate 
History Record(s).  Details are located under Section 25 of this document. 
 

Additional file maintenance to the 11710-A records may be required after 
generating the 11710-D report which is referenced later on in this document.  
Therefore, the 11710-A reports should not be printed until this reconciliation has 
been performed. 
 

11.13. ADD NEW SECURITY HOLDERS 
 

Add any new Security Holders for newly issued Ginnie Mae Certificates.  This 
option is located under ‘Security Holder Administration’ instead of ‘Pools’ so you 
will need to change your selection at the top of the Agency Reporting>Ginnie 
Mae screen.  You will most likely only have to perform this step once to add the 
Security Holder Record for the Book Entry Entity.  All Certificates are now issued 
to the same entity. 
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Select ‘Security Holder Administration’  

 
 

Confirm that the applicable ‘Security Holder Information’ record exists 
under the ‘Security Holder Administration’ menu prior to adding Certificate 
Record.  This is a one time setup for each Security Holder. 
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Add Security Holder Information: 
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Switch back over to the ‘Pools’ selection screen: 
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When accessing certain menu options from the ‘Agency Reporting – Ginnie Mae’ 
module Strategy will display the ‘Pool Search’ window.  This allows you to select 
the applicable Ginnie Mae Investor Number if there are multiples. 
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12.14. ENTER # OF CERTS IN NEWLY ISSUED POOLS-OBSOLETE 
 
 

Select ‘Pool Information’ and enter the # of new Certificates issued during 
the Current Reporting Month.  At this time you will only be adding and setting 
up NEWLY ISSUED Certificates.  The instructions for surrendering existing 
Certificates and adding replacement Certificates are later on in the Ginnie Mae 
Reporting Process.   
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Enter in the ‘# of Certificates’ in the Pool record; Strategy File – PIRPL.  Initially, 
the Pool Detail record may be in ‘Exception’ status since the Certificate 
Information hadn’t been entered yet.  Once you update the Pool Detail record 
and add the Certificate record the Pool will no longer be in ‘Exception’ status. 
 

 
Key in the ‘# of Certificates’ and Click on [OK] to save the change. 
 
If applicable, you can also enter the ‘Pool Tax ID’ here in the pool record. 
This step has been alleviated.  The ‘# of Certificates’ in the Pool record is now 
automatically updated as new certificates are added and existing certificates are 
surrendered. 
 

13.15. ADD CERTS FOR NEW POOLS & RECALCULATE PRO RATA 
SHARE 

 
 

Add Certificate Information on only the NEWLY ISSUED Certificates: 
 
The first time you access the Certificate Information screen you will receive the 
‘Certificate Search’ window.  This will not display if you remain in the Reporting 
module and go to select another Pool/Certificate.  It works the same way the 
‘Pool Search’ window does by displaying when initially opening the module but 
once an Investor is selected the user won’t keep receiving this screen. 
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Enter the highlighted information.  If there are multiple Certificates you will add 
multiple records.  Do not enter and have to manually calculate the ‘Pro Rata 
Share’ for each Certificatesince it will be calculated after entering all Certificates.  
This information displayed here is for the 0905/2008 2015 Reporting Cycle.  Click 
on [OK] to save changes. 
 
After entering all Certificates, enter the correct Pool Principal Balance to be used 
for recalculation of Pro Rata Share and then click on the Run button.  The 
balance defaults to the Pool Principal Balance this Monthend from most recent 
Pool History record (PIRPLH.PHBPP).   
 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 75 of 159 

If the balance is left at “0.00” and ‘Run’ is selected, a msg will display letting you 
know a 0.00 balance is not allowed.  At such time, a different balance must be 
entered or you can ‘Cancel’ to exit out of window.  
 

 
 
Each time the recalculation program runs a new entry is created in the Pro Rata 
Share History file PPRSHAREH. 
 
After successfully running the Recalculation Pro Rata Share program the 
entering “# of Certificates” in the Pool record is automatically updated and adding 
applicable Certificate records the Pool is will no longer be in ‘Exception’ status 
due to this reason “The Number of Certificates do not match”. Repeat for all 
newly issued pools. 
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14.16. ADD NEW CERTIFICATES FOR PREVIOUSLY ISSUED POOLS 
 
In cases where ownership of a Certificate has been transferred the user will 
need to add the NEW Certificate(s) and Surrender the OLD Certificate(s).  
The new one must be added first. 
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Complete entries in designated fields for new certificate.  Certificate was 
surrendered on 09/08/2008, 1st payment to Security Holders on new Certificate is 
10/15/2008, Last Report Updated is 08/2008.  The ‘Last Report Updated’ field 
in the new Certificate record must equal the ‘Last Report Updated’ in the 
corresponding Pool Record or the pool will go into ‘Exception’ status.  The 
‘Current Balance’ of the new Certificate record must equal the ‘Current Balance’ 
in the corresponding Pool Record or this will also cause the pool to go into 
‘Exception’ status.   
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15.17. SURRENDER CERTIFICATES FOR PREVIOUSLY ISSUED POOLS 
 

On the same screen, select the old certificate by highlighting it and perform a 
right mouse option and select ‘Certificate Surrender’.  User will be prompted to 
enter the ‘Surrender Date’.will receive message to confirm the action. 
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This performs the following actions in the old Certificate record: 

 Zero out ‘Pro Rata Share’ 

 ‘Active Status’ = “N” 
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 Zero out ‘Current Balance’ 

 Populates ‘Date Surrendered’ with day the action is performedentered.  If 
you want this date to reflect the actual date the certificate was surrendered 
the date must be file maintained. 

 Creates ‘Certificate Surrendered’ report. 
 

 

 
Remaining Certificate Surrendered report: 
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16.18. UPDATE # CERTS IN POOL FOR 1 TO MULTIPLE XFERS-
OBSOLETE 

 

In cases where one Certificate is being transferred into multiple Certificates the 
user will also have to update the # of Certificates in the Pool record: 
 

 
 

This step has been alleviated.  The ‘# of Certificates’ in the Pool record is now 
automatically updated as new certificates are added and existing certificates are 
surrendered. 
 
If applicable, you can also enter the ‘Pool Tax ID’ here in the pool record. 
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17.19. VERIFY APPLICABLE POOLS ARE NOT IN EXCEPTION STATUS 
 
 

Verify that all Pools with a Current Balance have a “Stat” of “Y” and are not 
in ‘Exception’ status. 
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18.20. CREATE AND PRINT 11710-D 
 
 

Create the on demand 11710-D Report from the Tools>Reports menu 
(Monthly Summary Report - MB638C): 
 

 

Click on [Run]  
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Click on [OK] to Run Report and place in spool file. 
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Above report was cutting off the Last Columns on the report – they are 
highlighted in Blue on the screen shot below. 
 

 

 
 

The 11710D Summary and Detail reports are generated from the ‘GNMA 
Reports’ widget in Portal.   
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The following options are available for the 11710D Summary report: 

 All GinnieMae Investors/Issuers or by specific Investor 

 Summary report will be rolled up based on Seller/Servicer # entered in 
Investor Vendor.  If there are multiple G1 Investors with the same 
Seller/Servicer # (Issuer #), the summary report will create a single form 
for all pools tied to those investors. 

 Issuer Name, Address and Zip Code information is retrieved from Address 
Lines 1-4 in the Investor Vendor record.  If multiple investors for same 
Seller/Servicer #, the information is retrieved from the last investor vendor 
record.  Recommend entering same data in Address Lines 1-4 for these 
investors. 

 Ability to generate a PDF or CSV file. 

 
 
After printing the 11710-D the amounts for ‘Total Escrow Funds’ and ‘Total 
Custodial Funds Other than T&I/All PoolsEscrow’ need to be verified against the 
Monthend cash balances in the Ginnie Mae T&I and Ginnie Mae P&I Custodial 
Accounts.   
 
The easiest way to perform the T&I reconciliation maybe to create a query 
comparing the applicable Escrow Balances in the Loan’s Master File to the 
amount being reported in Section 5B-1 ‘Tax and Insurance Funds’ on the 
corresponding Pool History Record (11710-A).  The balances should also be 
compared to the Monthend Custodial Escrow Balance in the Investor Vendor 
record(s).  If the Custodial Suspense Bank/DDA# matches the Custodial Escrow 
Bank/DDA# in the Investor Vendor record, then the suspense balances for pools 
tied to the investor will be included in the Total Escrow Funds balance. 
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Reconciling the ‘Total Custodial Funds Other than T&I/All PoolsEscrow’ entails 
looking at the Delinquent and Prepaid Loans, Loans with Suspense and/or 
Prepayment Penalties being held in the Custodial P&I Account., and the penny 
differences reflected in Section 5B-2 on the 11710-A reports.  If the Custodial 
Suspense Bank/DDA# matches the Custodial P&I Bank/DDA# in the Investor 
Vendor record, then the suspense balances for pools tied to the investor will be 
included in the ‘Total Funds Other than Escrow’ balance.  In most cases, if a loan 
is current and doesn’t have any Suspense Payments being held the net effect of 
Section 5B-2 and 5B-3 should be zero. 
 
The easiest way to perform the P&I reconciliation maybe to create a query pulling 
in the 11710-A amounts being reported in Section 5B-2 ‘Principal and Interest’ + 
Section 5B-3 ‘Other’ and reviewing the ones with a net balance.  Another query 
can be created to pull in the Delinquent and Prepaid Loans, as well as loans with 
Suspense Payments being held in the Custodial P&I Account.  The balances 
should also be compared to the Monthend Custodial P&I and Suspense 
Balances in the Investor Vendor record(s).  
 
If required, make the necessary adjustments to the applicable 11710-A records in 
Sections 5B1, 5B-2, and 5B3.   
 
Additional Reconciliations: 
 

 Compare the Guaranty Fee Total on the RPB Call-In Report 
MB617A to the total on the 11710-D. 

 Compare the Security Balance Total on the RPB Call-In Report 
MB617A to the total on the 11710-D.  

 Compare the Pool Principal Balance on RPB Call-In Report 
MB617A (fourth column on the report) to the total on the 11710-D. 

 
 
Reprint the 11710-D and verify all amounts have been reconciled.  
 
The 11710D Detail report (MB638C) is also is available in PDF or CSV format. 
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19.21. CREATE AND PRINT 11710-A 
 

The Monthend Cutoff produces a file containing pool history records (11710-A 
reports) for the current reporting month and they can be printed at that time if no 
changes are necessary.  It is recommended to print them after all of the 
reconciliations have been completed.   
 
The GinnieMae 11710-A reports can no longer be generated on demand as 
follows: 
 

Tools>Reports 
Module = Investor Processing 
Report Description = Monthly Accounting Report (Report - MB638J) 
 

 
Highlight the ‘Monthly Accounting Report’ and click on [Run]. 
This report is still available for FannieMae pools.  If a GinnieMae Investor is 
selected a message will display directing you to produce the reports in 
Portal. 
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You have to shift to the right to see the remaining fields, plus [Page Down] to 
see all of the report.    
The 11710A reports are generated from the ‘GNMA Reports’ widget in Portal.   
 

 

 

The following options are available for the 11710A report: 

 All or Selected GinnieMae Issuers, Investors, and Pools 

 Ability to generate a PDF or CSV file. 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 95 of 159 

 
 

The 11710-A and 11710-D information has now been verified and if necessary 
printed.   
 

22. CREATE AND PRINT 11710E 
 

The 11710E reports are generated from the ‘GNMA Reports’ widget in Portal.   
 

 

 

The following options are available for the 11710E report: 

 Loan – key in Strategy Loan # or use the Loan Search 

 All or Selected GinnieMae Issuers, Investors, and Pools 

 Ability to generate a PDF file. 
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The liquidation records created at cutoff can be viewed from the GinnieMae 
Agency Reporting window under ‘Liquidations’.   
 
The Liquidation window uses the new file PMBSLG. When the window is opened 
all records in the PMBSLG file will be retrieved. The Filter Options will allow the 
user to find records based on any or all of the parameters shown below.  
 
The Account#, Reporting Month, Pool Number, Investor Number, and Reason for 
Removal fields cannot be updated in existing records.   
 
Data can only be entered in the Account#, Reporting Month and Pool Number 
fields when a new record is added.  Strategy will not allow duplicate records 
where the Account#, Reporting Month, and Pool Number are the same.  
 
Records can also be deleted from this window. 
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20.23. RFS REPORTING  
 

RFS File Names 
 

PGNMARFS (pf) - Ginnie Mae RFS Reporting file  

 Record name RGNMARFS 

 File is cleared each time the RFS File is created using GNMA Menu 
Option 4 – Create GNMA RFS Reporting File.  

PRFSCRTH (pf) - RFS Reporting File Creation History 

 Record name RRFSCRTH 

 File contains summary information, User Name, Creation Date and Time. 
PSENSLOAN (pf) – Sensitive Loan Records for Ginnie Mae RFS Reporting 

 Record name RSENSLOAN 

 This file will be cleared when option 4 “Create GNMA RFS Reporting File” 
is selected from the GNMA menu. 

LSENSLOAN (lf) – logical view of PSENSLOAN by Issuer Nbr  

 Key file by SLISSNBR 
PIMSTADL (pf) – Additional information for PIMST – temporary file containing 
Ginnie Mae Unique Loan ID 

 Record name RIMSTADL 
LIMSTADL (lf) – logical view of PIMSTADL by Loan Key 

 Key file by I2LNKEY 
PIRLL (pf) – Loan Records for Ginnie Mae RFS Reporting 
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 Record name RIRLL 
LIRLL1 (lf) – logical view of PIRLL by Issuer Number 

 Key file by: 
o LLRPTDT 
o LLISSNBR 

LIRLL2 (lf) – logical view of PIRLL by Account Number 

 Key file by LLISLNID 
 
LIRLL3 (lf) – logical view of PIRLL by Investor Number  

 Key file by LLINVNBR 
 
LIRLL4 (lf) – logical view of PIRLL by Investor Number, Pool and Date  

 Key file by: 
o LLINVNBR 
o LLPOOLID 
o LLRPTDT 

PIRPLH (pf) – Pool History Information  

 Record name RIRPLH 
PIRPLHADL (pf) – Additional Pool History Information  

 Record name RIRPLHADL 
LIRPLHA1 (lf) – logical view of PIRPLHADL by Issuer Number  

 Key file by:  
o PHARCC 
o PHARYY 
o PHARMM 
o  PHISSNBR 

PVARLOAN (pf) - Various Loan Records 

 Record name RVARLOAN 

 This file will be cleared when option 4 “Create GNMA RFS Reporting File” 
is selected from the GNMA menu. 

LVARLOAN (lf) - logical view of PVARLOAN by Issuer Number 
Key = LVISSNBR 
 

In order to provide the required reporting functionality in a timely manner the new 
functionality was created in a Green Screen environment.  The new functionality 
will be added to StrategyCS in a subsequent general release. Strategy creates a 
flat file, ASCII text format. 
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All of the Ginnie Mae RFS reporting screens are accessed via Green Screen.  
From the ‘Master Menu’ select option “5”. 
 

Ginnie Mae Loan Key Maintenance (File-PIMSTADL) - Option 1 
 
For the initial reporting on new pools the Ginnie Mae Loan Key MUST be entered 
using the GNMA Menu Option1 – ‘GNMA Loan Key Maintenance’.  The change 
must be made prior to running the monthend cutoff or it will be reported as all 
zeroes.  The unique Ginnie Mae Loan ID is a key to the reporting file so this field 
is protected under the GNMA Menu Option 3 – ‘Ginnie Mae Loan Maintenance’; 
file maintenance is not permitted. 
 
Since the Loan Keys have to be setup as part of the new loan setup the 
screen details were previously referenced in this document under Section 3 – 
‘Critical Ginnie Mae Loan Setup Information’.  The information and screen shots 
are repeated in this section.  
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Entering a “?” by the fields with an asterisk and hitting [Enter] will display all 
Ginnie Mae Investor Numbers and all Account Numbers for that Investor. 
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After making your selection this screen appears; hit [Enter] again. 
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The Loan Key cannot be changed after the monthend cutoff.  Any changes made 
after the cutoff will not be picked up until the following Reporting Month.  It is 
critical that the Loan Key is entered prior to running the monthend cutoff.   
 
The Ginnie Mae Unique Loan ID is stored in File – PIMSTADL: 
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Ginnie Mae Additional Pool History (File-PIRPLHADL) - Option 2 
 
There maybe some additional fields that needs to be manually maintained in 
order to populate the data in the applicable RFS Reporting Files.  The 
information entered here is stored in the ‘Additional Pool History Information File’ 
– PIRPLHADL.  Even though the ‘Replacement Reserve Bank’ and ‘Construction 
Loan Prin Bank’ Names will no longer be reported via the RFS file we will 
continue to retrieve the information into the Strategy files, and display the Bank 
Names on this window.   
 
The fields that can be file maintained on this screen are:   
 

 Replacement Reserve:  Balance, Bank Account #, Bank Name, and Bank 
ABA #.  The first two fields are retrieved from the Reserve Balance file and 
the last two are from the Bank Vendor file; picks up the Bank and Account 
information from the 1st designated Ginnie Mae Reserve Record. Fields 
are:  PRBL.RBBAL, PRBL.RBDDA, PBANK.VBNAME, and 
PBANK.VBABA#.   

 P&I Bank ABA #:  retrieves the Bank Id from the Investor Vendor record 
and then pulls the corresponding ABA# from the Bank Vendor file 
(PBANK.VBABA#). 

 T&I Bank ABA #:  retrieves the Bank Id from the Investor Vendor record 
and then pulls the corresponding ABA# from the Bank Vendor file 
(PBANK.VBABA#). 
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 Construction Loan:  Principal Balance (represents the Principal portion of 
the payment collected when construction has not been completed prior to 
the required commencement of amortization-not applicable for Single 
Family Pools), P&I Bank Account #, P&I Bank ABA #, and P&I Bank 
Name.  The Construction Bank Account #, ABA# and Bank Name are 
populated with the P&I Account information stored in the Investor Vendor 
file and the corresponding Bank Vendor file (PINVES.IVC#PI, 
PBANK.VBNAME, and PBANK.VBABA#).   

 
The ‘Construction Loan Prin Balance’ field is the only field that isn’t 
programmatically populated.  If principal payments are being collected on a 
Construction Multifamily Pool the amount will need to be file maintained for 
each reporting period.    

 

In order for the changes to get updated in the RFS Reporting File (PGNMARFS) 
you have to recreate the reporting file by selecting Menu Option 4 - Create 
Ginnie Mae RFS Reporting File. 
 

 
 
 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 105 of 159 
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After making your selection this screen appears; hit [Enter] again. 
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Any changes made will create an entry in the File Maintenance File (PFMHST).  
All file maintenance entries are stored in the Physical File – PIRPLHADL except 
for the Replacement Reserve Balance which is stored in PIRPLH.   
 

Ginnie Mae Loan Maintenance (File-PIRLL) – Option 3 
 

This screen displays the information that was populated in the RFS Reporting 
File from running the monthend cutoff.  The only fields that are protected on this 
screen are:  Issuer Loan ID/Acct#, Ginnie Mae Loan Key, and Investor Number.  
All other values can be file maintained on this screen.  Depending on which data 
fields are changed, various edit messages will display requiring you to change 
additional information on the screen.  For example:  if you change the ‘Last Install 
Paid Dt’ you will be prompted to make changes to the Delinquent P&I and Install 
P&I Collected fields.   
 
In order for the changes to get updated in the RFS Reporting File (PGNMARFS) 
you have to recreate the reporting file by selecting Menu Option 4 - Create 
Ginnie Mae RFS Reporting File. 
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Enter the applicable Reporting Date.  The specific Pool Number can be entered 
to bring up a single record or you can enter “?” by the Pool Number field and hit 
[Enter] to display all Pool Numbers. 
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Enter a “1” next to the applicable Account #.  If there are multiple loans in a 
single pool all of the loan records will display on this menu. 
 
 
 

 
 
Any changes made will create an entry in the File Maintenance File (PFMHST).  
All file maintenance entries are stored in the Physical File – PIRLL. 
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Ginnie Mae Sensitive Loan Record (File-PSENSLOAN) 
 

Per the Ginnie Mae Handbook 5500.3, Rev. 1, Appendix VI-19: 

 Issuers should use the Sensitive Loan Record only to make changes to 
incorrect or incomplete data.   

 If there is a change to report in one or more of the five borrower fields in 
the Sensitive data record, the Issuer should submit all borrower fields for 
reprocessing, including those for which there are no changes.  Strategy 
automatically includes all records. 

 Any reporting of Social Security Number (SSN), First Name, or Last Name 
fields in the Sensitive record should include reporting of all SSN, First 
Name, or Last Name fields in the record; this ensures that all borrower 
data for the loan is accurate and complete. 

 

The Primary and Additional Borrowers’ information is setup in the Loan 
Administration module which is accessed as follows:  File>Module List>Loan 
Administration.  Go to the ‘Customer Info’ tab. 
 
A new ‘Role Type’ of “GMAB” has been created to identify any Additional 
Borrower records that should be reported in the Ginnie Mae RFS Sensitive 
Record.   
 
If there are Additional Borrower Records that need to be included in the Ginnie 
Mae RFS Sensitive Record they need to be added with the GNMA RFS 
Additional Borrower Role Type (“GMAB”).  Right mouse click on the main screen 
and go to ‘Roles’.  The ‘Associated Name Roles’ information is stored in file – 
PROLELOAN.  Associate the ‘Role Type’ with the Additional Borrower Record. 
 

The ‘Primary Borrower’ and ‘Additional Borrower’ record information is captured 
and populated in the Ginnie Mae Sensitive Loan Record (File - PSENSLOAN).  
‘Primary Borrower’ is populated in the ‘First Name 1’ and ‘Last Name 1’ fields. 
 
When there is a Company Name (field NMCONAM/file PNAME), it will populate 
Field #8 (First Name 1). When the Company Name is > 25 characters, it will 
overflow into field #9, (Last Name 1). If the Company Name is not long enough, 
Field #9 used to be blank. In order to avoid an exception and the RFS file to be 
rejected, now if the Company Name is not long enough the First Name 1 field is 
copied to the Last Name 1 field.   
 

  ‘Additional Borrower’ information is populated in the ‘First Name 2 - 5’ and ‘Last 
Name 2 - 5’ fields.  The RFS file contains the following fields: Tax ID#/SSN #, 
First and Last Name or Company Name. 
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In order to access or include a Sensitive Loan Record in the RFS Reporting File 
you need select Menu Option 4 - Create Ginnie Mae RFS Reporting File. 
 
The Sensitive Loan File - PSENSLOAN will be cleared when option 4 “Create 
GNMA RFS Reporting File” is selected from the GNMA menu. 
 
 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 112 of 159 

 
 

 
 
 

Key in the ‘Reporting Date’ and enter a “Y” in the field ‘Include Sensitive Records 
Y/N’.  You have the option to include either:  Sensitive Records, Various Loan 
Records, or both. 
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Select whether or not you want to include all records or just updated records in 
the Reporting File, and whether or not the loan information should be 
summarized to the pool level.  The ‘Summarize Flag’ value gets populated in the 
Trailer Record.  Based on whether the flag is set to “Y” or “N” the following will 
occur: 

 “Y” indicates that the issuer reporting/file submission is complete and 
Ginnie Mae should proceed with summarization of loan detail to the 
pool level. 

 “N” indicates Ginnie Mae should accept the submission but not 
summarize the loan data to the pool level.  

 
Hitting [Enter] will bring up the Selection screen.   
 

 
 
A record will display on this screen for each record in the Loan Records file 
(PIRLL) for the Reporting Period entered on the previous screen.   
 
Only the selected records will be written to the Sensitive Loan Records file 
(PSENSLOAN) and then ultimately to the Ginnie Mae RFS Reporting File 
(PGNMARFS).    
 

Strategy will automatically include all five Borrower Records for each of the 
‘Selected Loans’. 
 
Hitting [Enter] will perform the following actions: 
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o Create the Ginnie Mae RFS Reporting File (PGNMARFS) on the AS/400, 
which will include Sensitive Loan Records for those accounts marked as 
Selected. 

o If no records were selected a pop-up window will display to determine 
whether processing should continue (shown below). 

 If “Y” is entered: the Ginnie Mae RFS Reporting file will be 
created, but without any Sensitive Loan Records.  The 
customer will then be returned to the Master menu 

 If “N” is entered: the Selection Screen will redisplay for 
record selection or the option to cancel out of the file 
creation via Cmd7.      

 

 
 
No File Maintenance entries are made to the Sensitive Loan File (PSENSLOAN) 
since changes made to the Borrower information would be logged to the 
applicable Name and Address files in the File Maintenance File (PFMHST).   
 

Ginnie Mae Various Loan Record (File-PVARLOAN) 
 

When RFS Reporting was initially created the Various Loan Record did not apply 
to multifamily, with the exception of the Debt Service Ratio which at the time was 
a “placeholder” (per Ginnie Mae).  Therefore the Various Loan Record was not 
included as a record type in the original job (#14763).   
 
The new reporting requirements effective for the September 2011 Reporting 
Period now require this file.  These changes have been done under Job #16495.  
The new “Various Loan Records” are in File - PVARLOAN. 
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This file will be cleared, as is the Sensitive Loan File - PSENSLOAN, when 
option 4 “Create GNMA RFS Reporting File” is selected from the GNMA menu. 
 
Per the Ginnie Mae Handbook 5500.3, Rev. 1, Appendix VI-19: 

 Issuers should use the Various Loan Record only to make changes to 
incorrect or incomplete data originally reported on the HUD Form 11706 – 
Schedule of Pooled Mortgages, at pool issuance.   

 Issuers should not report the Various Loan Record if no changes are 
present.   

 Various Loan Records may be submitted with blanks for fields with values 
that are not being reported or changed.  The Issuer should report only 
fields on the Various Loan Record that is to be updated in RFS.  

 Any fields that are being reported on the Various Loan Record must have 
valid values per the layout and field instructions in this document.  Invalid 
values will not be accepted. 

 
Select Option 4 from the GNMA Menu to access the Various Loan Records. 
 

 
 
 
The field “Include Various Loan Records Y/N” has been added to the Ginnie Mae 
Create RFS Reporting File screen.  
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In order to include Various Loan Record(s) in the Ginnie Mae Reporting File a “Y” 
must be entered in the ‘Include Various Loan Records Y/N’ field which will bring 
up the Selection screen.  You have the option to include either:  Sensitive 
Records, Various Loan Records, or both. 
 
Select whether or not you want to include all records or just updated records in 
the Reporting File, and whether or not the loan information should be 
summarized to the pool level.  The ‘Summarize Flag’ value gets populated in the 
Trailer Record.  Based on whether the flag is set to “Y” or “N” the following will 
occur: 

 “Y” indicates that the issuer reporting/file submission is complete and 
Ginnie Mae should proceed with summarization of loan detail to the 
pool level. 

 “N” indicates Ginnie Mae should accept the submission but not 
summarize the loan data to the pool level.  

 
Hitting [Enter] will bring up the Selection screen.   
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A record will display on this screen for each record in the Loan Records file 
(PIRLL) for the Reporting Period entered on the previous screen.   
 
The new Various Loan Records screen displays:  Account # and Loan Key 
(GNMA Unique Key), with maintainable fields for:  Loan To Value (automatically 
gets populated with value stored in PMASTR.CMOLTV), Debt Service Ratio, 
MIN, and MERS Original Mortgagee.  These are the only fields that apply to 
Multifamily Loans.   
 
Only the selected records will be modified, because only the selected records will 
be written to the Various Loan Records file (PVARLOAN) and then ultimately to 
the Ginnie Mae RFS Reporting File (PGNMARFS).    
 
Since the value in the Loan To Value field is automatically populated it will 
need to be manually cleared if no change to this value is being reported.  
For example:  if Debt Service Ratio is the only value that has changed then you 
would need to clear the value in the Loan To Value field and key in the new Debt 
Service Ratio.  If LTV isn’t cleared the Ginnie Mae Reporting File will contain 
values in both the LTV and DSCR fields when it should only have a value in the 
DSCR field. 
 
On this screen the customer will select all the accounts a Various Loan Record 
should be created for.  This is done by keying a “1” in the “Sel” field for each of 
the accounts to be included (don’t hit [Enter] until you have made the applicable 
change(s).   
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For each “Selected” record: 

 Data should be entered into any field that needs to be reported  
o For example, the MIN code should be entered for the selected 

record if it needs to be reported.  

 Data should be cleared from any field that does not need to be reported  
o For example, if the Loan To Value does not need to be reported for 

the selected record it should be zeroed out.  
 
Cmd7 will return the customer to the GNMA Menu without creating the Ginnie 
Mae RFS file. 
 
Hitting [Enter] will perform the following actions: 

o Create the Ginnie Mae RFS Reporting File (PGNMARFS) on the AS/400, 
which will include Various Loan Records for those accounts marked as 
Selected. 

o If no records were selected a pop-up window will display to determine 
whether processing should continue (shown below). 

 If “Y” is entered: the Ginnie Mae RFS Reporting file will be 
created, but without any Various Loan Records.  The 
customer will then be returned to the Master menu 

 If “N” is entered: the Selection Screen will redisplay for 
record selection or the option to cancel out of the file 
creation via Cmd7.      
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No entries will be made to the File Maintenance File (PFMHST) for the Various 
Loan Records File (PVARLOAN).   
 
 
Create GNMA RFS Reporting (File-PGNMARFS) – Option 4 
 
 

Running the “Create GNMA RFS Reporting File” Green Screen option will clear 
and repopulate the following files:  PSENSLOAN, PVARLOAN, and PGNMARFS 
(record length 460 characters) based on the customers selections.  The flat file, 
ASCII text format will contain the above record types (as selected by the user) in 
the layout specified by Ginnie Mae.  This new Ginnie Mae RFS Reporting file will 
exist on the AS/400.   
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When the Create Ginnie Mae RFS Reporting File option runs the following will 
occur: 
 The files:  PSENSLOAN, PVARLOAN, and PGNMARFS will be cleared. 
 A Header record will be written to file PGNMARFS using the new Header 

record layout. 
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 When “Include all Pool History/Loan Records” is “Y” the following will 
occur: 
 All records in the Pool History files (PIRPLH and PIRPLHADL) for the 

Reporting Date entered will be written to file PGNMARFS using the 
new Pool History record layout. 

 All records in the Loan file (PIRLL) for the Reporting Date entered will 
be written to file PGNMARFS using the new Loan Record layout. 

 When “Include Only Updated Pool History/Loan Records” is “Y” the 
following will occur (See Note A below): 
 Only records in the Pool History files (PIRPLH and PIRPLHADL) for 

the Reporting Date entered with a “Wrote to RFS File” value of blank 
will be written to file PGNMARFS using the new layout. 

 Only records in the Loan file (PIRLL) for the Reporting Date entered 
with a “Wrote to RFS File” value of blank will be written to file 
PGNMARFS using the new layout. 

 When “Include Sensitive Records” is “Y” the following will occur: 
 A Sensitive Record will be written to file PGNMARFS for each account 

that was selected for inclusion using the new Sensitive Record layout. 
 When “Include Various Loan Records” is “Y” the following will occur: 

 A Various Loan Record will be written to file PGNMARFS for each 
account that was selected for inclusion (records will be in file 
PVARLOAN) using the new Various Loan Record layout.  

 The Summarize Flag value gets populated in the Trailer Record and 
indicates to Ginnie Mae whether or not the loan information should be 
summarized to the pool level.  Based on whether the flag is set to “Y” or 
“N” the following will occur: 
 “Y” indicates that the issuer reporting/file submission is complete and 

Ginnie Mae should proceed with summarization of loan detail to the 
pool level. 

 “N” indicates Ginnie Mae should accept the submission but not 
summarize the loan data to the pool level.  

 A Trailer record will be written to file PGNMARFS using the new Trailer record 
layout. 

 An RFS Reporting File Creation History file (PRFSCRTH) record will be 
created with the Trailer record information, User Name, Date and Time. 

 

**Note A:  The Pool History (PIRPLHADL) and Loan Records (PIRLL) “Wrote to 
RFS File” field: 

 Is blank when Pool History and Loan Records are created during the day 
end cut-off 

 Is updated to “Y” when the Pool History and/or Loan Record are written 
to the RFS Reporting file 

 Is updated to blank when a Pool History and/or Loan Record are 
updated via file maintenance by the customer 
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In this manner when “Include Only Updated Pool History/Loan Records” is 
“Y” only those records that have been updated (i.e., corrected) or not previously 
written to the RFS Reporting file will be included.   
 
Note: It is assumed that when the “Create GNMA RFS Reporting File” option is 
run the customer will be creating a submission file from the AS/400 file 
PGNMARFS.  Therefore file PGNMARFS will be cleared every time the 
“Create…” option is run, before repopulating the file. 
 
Ginnie Mae is allowing file submission via different technologies.  Therefore each 
customer can retrieve the PGNMARFS file from the AS/400, name it 
appropriately, and submit it to Ginnie Mae in the manner they prefer.   
 

File – PGNMARFS 
 

 
 

Sample file above contains:  Header and Trailer Records for each Issuer, Pool 
Records, Loan Records, Sensitive Loan Records, and Various Loan Records 
(depending on your selections). 
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21.24. UPDATE POOLS FROM AND CREATE CERTIFICATE HISTORY  
 
 

Update Pools from History and Create Certificate History (THIS OPTION 
SHOULD ONLY BE RUN ONCE): 
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For GinnieMae, the menu option has been changed to combine both the ‘Update 
Pools From History’ and the ‘Create Certificate History’ option on the Security 
Holder Administration menu.  This will now be a one step process and will update 
both the Pool and Certificate records.  The ‘Create Certificate History’ option has 
been removed from the Ginniemae Security Holder Administration menu. 
 
The new option is only available on the GinnieMae Agency Reporting window.  
The ‘Update Pools From History’ option on the Fannie Mae and FHA Project Pool 
Agency Reporting menus are still available.  The options have been fixed where 
if run from the FannieMae Agency Reporting menu it will only run for FannieMae 
pools, and the same for the FHA Project Pool Agency Reporting menu.   
 
A new message will display on the GinnieMae Agency Reporting Title bar.  If the 
‘Update Pools and Create Certificate History’ option has not been run for the 
current reporting month a Reminder message will display.  If the option has 
already been run for the current reporting month the message will state it has 
already been run.   
 
When the GinnieMae Agency Reporting option is selected from the Investor 
Master module, a search is performed on every G1 pool.  If there is any active 
pool (Pool Status = “Y”) where the ‘Last Report Updated’ date is less than the 
current cutoff date then the Reminder message will display.  The ‘Update Pools 
From History’ option can be run without having an adverse effect on the Pools or 
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Certificate History records already created for the current cutoff date.  This 
situation would only occur if a pool record had been manually added with an 
incorrect ‘Last Report Updated’. 
Currently, whenever the ‘Update Pools From History’ option is run (whether it’s 
run from the Fannie Mae, Ginnie Mae or FHA Project Pool Agency Reporting 
menu) it’s performing this step for all three types of Program Ids all together:  
Fannie Mae (C5), Ginnie Mae (G1), and FHA Project Pools (H2).  Therefore, the 
timing of running this option will need to be coordinated between the various 
Investor Reporting groups. 
 
McCracken Financial Solutions is researching this issue.  This function should be 
modified so that it only runs for the specified Program ID.  If the option is run from 
the Fannie Mae Agency Reporting menu it should only update the C5 pools.  If 
it’s run from the Ginnie Mae Agency Reporting menu it should only update the 
G1 pools.  If it’s run from the FHA Project Pool Agency Reporting menu it should 
only update the H2 pools.  The update needs to occur separately for each 
Program ID since the various agencies have different reporting 
deadlines/timeframes. 
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If there are any issues, aAn exception report is placed in your spool file.  The 
report is now GR650G1.  This report should be reviewed. 
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After option is run it updates the ‘Last Report Updated’ and ‘Current Balance’ 
fields in the Pool record.  The ‘Current Balance’ will equal the ‘Principal of 
securities this mothend’, Section 3D of the 11710A.  The balance used to be a 
month behind. 
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Certificate History (11714 or Remittance Advice uses data in the Certificate 
records to reflect payments being made to the Security Holders). 
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22.25. CREATE CERTIFICATE HISTORY 
 
 

From the ‘Agency Reporting – Ginnie Mae’ screen, switch from ‘Pools’ to 
‘Security Holder Administration’ by clicking on the radio button. 
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For GinnieMae, there is no longer a separate menu option to ‘Create Certificate 
History’ since it is included in the new ‘Update Pools From History’ and the 
‘Create Certificate History’ menu option.  This will now be a one step process and 
will update both the Pool and Certificate records.  The ‘Create Certificate History’ 
option has been removed from the Ginniemae Security Holder Administration 
menu. 
 
The new option is only available on the GinnieMae Agency Reporting window. 
  

  
Create Certificate History (11714 or Remittance Advice uses data in the 
Certificate records to reflect payments being made to the Security 
Holders).: 
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23.26. REVIEW CERTIFICATE HISTORY EXCEPTION REPORT 
 

A “Certificate History Exception Report” is generated and can be printed.  The 
report is now MB650H3.  This report should be reviewed.  The File Name in the 
Spoolfile is “QSYSPRT”. 
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User can view the newly created history record: 
 

 
The Certificate History is stored in Strategy File – PIRCRTH. 
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Adjustments to Certificate History Records: 
 

It may be necessary to make aAdjustments to the Certificate History Record(s) 
on new Pools that were issued on amortized loan balances should automatically 
be picked up.  If adjustments to the principal amount being remitted to the 
Security Holder were performed on the 11710-A then the same adjustment will 
need to be made to the Certificate History Record(s) to bring the Pool and Loan 
in sync. 
 
Refer to tThe ‘Pool to Security Balance Reconciliation’ Report – MB638R 
(Section 23 27 of this document) to getreflects these adjusted amounts.  The 
adjustment will display under the ‘AP Adjustment Other Section 2-D’ column.  
Enter the amount displayed in this column inThe adjustments will be made in the 
‘Additional Principal’Adjustments’ field in the applicable Certificate History 
Record(s).  This may be a negative number.  This is the final step to bring the 
Loan, Pool, and Certificate in sync on those Pools issued on amortized loans.  
 

The Certificate History Records on liquidated Pools should also be reviewed to 
ensure the Current Balance is equal to zero.   
 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 135 of 159 

Certificate record after ‘Creating Certificate History’, Strategy File - 
PIRCRT: 
 

 
 

 

The Certificate Record contains the YTD Information. 
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24.27. PERFORM POOL TO SECURITY RECONCILIATION 
 
 

Perform Pool to Security ‘Reconciliation’ option and confirm there are no 
“Differences”: 
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Remaining part of the Reconciliation Report: 
 
 

 

 

 

There was a setup issue on one of the “test” pools which caused the ‘Difference’ 
to reflect on this report.   
There will be a “Difference” on the report for those pools where the Investor 
Master Record Status Code is changed to “R” or “F” prior to cutoff.  This is due to 
the fact that the ‘Last Principal Installment on Liquidation’ on the report is 
retrieved from the Investor Remittance record for the loan payoff transaction.  
Since these types of liquidations don’t require the payoff of the loan to be posted 
the amounts won’t be picked up on the report resulting in a “Difference”. 
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25.28. CREATE AND PRINT 11714 (REMITTANCE ADVICE) 
 
 

Create the Remittance Advice reports (11714) and print if necessary: 
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Additional fields to the right on GNMAREMIT (11714) report: 

Remaining fields at bottom of GNMAREMIT (11714) report: 
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26.29. CREATE ELECTRONIC 11714 REPORTING FILE 
 

From the ‘Agency Reporting – Ginnie Mae’ screen, switch from ‘Security 
Holder Administration’ back to ‘Pools’ by clicking on the radio button. 
 
Create 11714 File - PGIA (this is the file that used to get imported into 
GinnieNet for transmission but is now transmitted using the Ginnie Mae 
Enterprise Portal): 
 

 
Creates file PGIA: 
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27.30. CREATE PRELIMINARY CHECK/WIRE REPORT 
 

Switch from ‘Pools’ to ‘Security Holder Administration’ 
 

Run Preliminary Check/Wire Report to review amounts being paid to 
Security Holders for all active pools: 
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28.31. VERIFY AMOUNT AND CREATE CHECK WRITING RECORDS 
 
 

Verify Remittance amount is correct and then create the check writing records: 
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**Investor Vendor record is set to ‘Hold Posting’ = “Y” so P&I won’t be debited 
until the custodial record is released 

 
 

29.32. RELEASE CUSTODIAL PROCESSING RECORD 
 
 

On the day that the remittance is being made and funds are sent to the 
applicable Security Holders, the P&I funds will need to be debited from the 
applicable Investor Vendor records.  This may require you to release an 
existing Custodial Accounting record or manually create the Investor 
Custodial Record to Debit the scheduled P&I Payments: 
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The Custodial Accounting records are accessed as follows:  
Investors>Tools>Custodial Processing.  Select ‘Daily Custodial File’ to view 
entries being held for release. 
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On the day of the Remittance, release the Custodial record by changing 
‘Hold Posting’ from “Y” to “N”.  After dayend is run the P&I amounts in the 
Custodial record will be debited from the Investor’s P&I Account setup in the 
Investor Vendor record. 
 

 
If customers don’t want the Ginnie Mae Investor’s Custodial P&I account on 
Strategy to go negative, users will have to add a manual custodial entry to Credit 
the P&I funds being advanced.   
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30.33. MISCELLANEOUS 
 
 

Loans in Pool 
 

If the user wants to verify which Strategy loans are in a specific pool they can 
view that information by taking this option: 
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Pool Search 
 

Users are able to search for a specific pool number in the Ginnie Mae Agency 
Reporting module.  This alleviates having to scroll down a long list of pools: 
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After selecting ‘Find’ the following dialog box is displayed: 
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31.34. SECURITY HOLDERS REGISTER 
 

In accordance with Section 12-7 of the GNMA Handbook, Strategy produces the 
GinnieMae I MBS register of security holders for each GinnieMae I pool. 
 
The Register must contain at least the following information for each security 
outstanding: 

 Pool Number 

 Certificate Number 

 Name, Address, and EIN of each Security Holder 

 Original Principal Amount of Security 

 Date of Issue of the Securities/Certificate 

 Interest Rate 

 Initial Payment Date 

 Maturity Date – Pulls from Pool Record 
 

Also, will include Totals for:  Certificate Balances and Pool Balance and perform 
comparison.  If the total of the Pool’s Certificate Balances does not equal the 
Pool Balance, report will reflect an Out of Balance amount.   
 
The Register must not be run until after the ‘Update Pools From History & Create 
Certificate History’ option has been run for the reporting cutoff. 
 
The MB650E GR650E report is generated by going to the GinnieMae Agency 
Reporting menu>Security Holder Administration section>Certificate Information 
window.  Select the right mouse option ‘Active Certificate Register’.  This creates 
report “GNMACRTREG”; User Data = GR650E in the spool file.  
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The Certificate Register can also be generated from the ‘GNMA Reports’ widget 
in Portal.  This report retrieves information from the Certificate History 
records so if the history record does not exist for the “Reporting Date” 
entered, then no certificate information will print for that pool.  
 

 

 

The following options are available for the Certificate Register report: 

 All GinnieMae Security Holders’ Tax ID or by specific Tax ID. 

 Ability to generate a PDF file. 
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35. WHIFIT REPORTING 
 
WHFIT Reporting was added to Strategy under Job #19811 in Release 19A.  The 
current functionality will generate the required WHFIT file with the calculated 
Market Discount Fraction (MDF).   
 
The current calculation uses the Strategy amortization schedule program and 
determines the End Date for the schedule by using one of the following Date 
Sources:  Maturity Date of the loan, Effective Date of the “PAR” Prepayment 
record, or a specified date entered into a new Strategy field. 
 
Initially, all pools will be set to use the Prepayment Effective Date from the “PAR” 
record.  Here is an example of the prepayment record: 
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SUMMARY: 
 

 Menu options 6-10 on the GinnieMae menu are used for the WHIFIT 
reporting. 

 User can calculate the Market Discount Fraction for all “G1” Pools for a 
given Reporting Date.   

 Calculation runs in Dayend/Monthend after other investor cutoff programs 
(I.e.  new pool history records have been created).  The 9/30/2013 
Dayend/Monthend will calculate the MDF for Reporting Month of 
September 2013. 

 The MDF Calculation only runs for “G1” Pools where the Pool Status is not 
equal to “N” (PIRPL.PLSTAT NE “N”). 

 All pools will be set to use the Prepayment Effective Date from the “PAR” 
record.  This will update a new field in the Pool record to store the Date 
Source (PIRPL.PLMDFSRC).  The field can be queried for verification. 

 Every month the program will retrieve the End Date for the amortization 
schedule by retrieving the ‘Effective Date’ from the Prepayment record 
where the ‘Prepayment Type’ = “PAR”.  For pools that contain multiple 
loans, the program will pull the Date from the first loan # found.  Since the 
date is being retrieved every month, the program will pick up any 
maintenance performed on the date since the previous month. 
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 Menu Option 6 allows user to change the Date Source to:  Maturity Date, 
Prepayment Date, or blank out the Source and key in a specified date.  If 
a date is keyed in, the program will populate this date in a new Pool level 
field (PIRPL.PLMDFDT).   

 The full amortization schedule will not be retained.  Instead, we have 
created a history file containing the identified/critical field values from the 
first line of the amortization schedule plus the Aggregate Amount of Net 
Interest Payments.  The new file – PMDFCALC can be queried.  The field 
listing for this file can be found below. 

 If the Pool History values used in the Market Discount Fraction calculation 
are changed via StrategyCS, the Pool’s MDF value will automatically be 
recalculated at the time the change is saved.  This applies to changes 
made to the following fields in the pool history record (11710-A):   

o Principal amount of securities from last report (Section 3-A in Pool 
History; PIRPLH.PHPAS) 

o P&I Constant = Constant (Section 1A-A in Pool History; 
PIRPLH.PHCON) 

 After the Dayend/Monthend cutoff, the PIRPLH records for all of the 
Interest Only Pools are manually updated to wipe out the P&I Constant, 
Interest, and Principal.  Saving these changes will trigger the recalculation 
of the MDF for each of these pools.  The MDF amount calculated at 
monthend will be incorrect due to the P&I Constant information in the Pool 
History record (11710-A). 

 Once a Pool has been reported with a MDF value = “1.0000000” the Pool 
is automatically flagged to no longer be included in the WHFIT Reporting 
file.  If necessary, this new field can be file maintained so the Pool 
continues to be included in the file. 

 OID will be reported as zeroes for all pools. 

 MDF and OID values will be stored in the existing Additional Pool History 
fields:  PIRPLHADL.PHMDSCFR  & PIRPLHADL.PHODSCNT. 

 These two (2) fields have been added to the Ginnie Mae Additional Pool 
History File Maintenance screen so they can be maintained (Option 2 on 
GNMA menu). 

 

 
REPORTING STEPS: 

 
The WHFIT program will automatically run during the GinnieMae Dayend or 
Combined Dayend/Monthend after the other investor cutoff programs.  The 
following steps should be followed to validate and create the reporting file: 
 

 Go to GNMA MENU OPTION 7 – Verification Reports; run the ‘MDF 
Calculation Date Verification Report’ for ALL Investors and Pools. 
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 Review the two reports; the Exception Report lists all the Pools where the 
Prepayment record is missing; the MDF value for these pools will be 
reported as 0.00 in the WHFIT file. 

 Enter the missing Prepayment records; rerun report 

 Go to GNMA MENU OPTION 8 – Recalc Market Discount Fraction; 
calculate the MDF for the applicable Reporting Date  

 Go to GNMA MENU OPTION 7 – Verification Reports; run the ‘MDF 
Amount Verification Report’ for ALL Investors and Pools with the 
applicable ‘Start’ and ‘End Record Dates’. 

 Review the 2 reports; the Exception Report lists all the Pools where the 
MDF Amount is greater than or equal to “1”; these pools will not be 
included in the WHFIT file unless it’s the first time the Pool is being 
reported with a MDF value = “1”.   

 Produce and review the ‘Exclude Pools Report’.  This report lists all of the 
Pools where the flag to exclude from WHFIT Reporting has been set to 
“Y”. 

 If you want to review the parameters used to calculate the MDF Amount 
on any of the pools you can query the new file PMDFCALC. 

 If necessary, run StrategyCS Amortization Schedules for validation.  
Instructions for running Interest Only and P&I schedules are at the end of 
this document. 

 If you want to use the Maturity Date or a specified date instead of the 
Prepayment Date you can enter this information and recalculate the MDF 
Amount for a given pool by going to GNMA MENU OPTION 6 – MDF 
Calculation Date Maintenance.  The MDF Amount for a single pool can be 
recalculated on this screen even if the date has not been changed.  User 
can find the new MDF amount various ways: 

o running the Verification Report 
o going into GNMA MENU OPTION 2 - Ginnie Mae Additional Pool 

History File Maintenance screen 
o querying PMDFCALC  

 Once you are satisfied with the MDF Amounts you can create the file for 
transmission using GNMA MENU OPTION 9 – Create WHFIT Reporting 
File (PWHFIT).  User selects range of Reporting Dates to be included in 
file.  PHWFIT can be queried for validation. 

 
 
Note: It is assumed that when the “Create WHFIT Reporting File” option is run 
the customer will be creating a submission file from the AS/400 file PWHFIT.  
Therefore file PWHFIT will be cleared every time the “Create…” option is run, 
before repopulating the file. 
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Users can run an Amortization Schedule in StrategyCS to verify 
the MDF calculation: 
 
Tools>Utilities>Amortization Schedule: 
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Select the radio button next to “Enter Data”: 
 

 
 
The data input will vary depending on if the schedule is being run for Interest 
Only or Principal & Interest. 
 
 



Ginnie Mae Loan Setup and Reporting Process at R17R19C September 2011July 2018 
Prepared by: Karla Ferguson  Page 157 of 159 

 
INTEREST ONLY:  This is the calculation that will be run for any pool 
(construction or permanent) where the Constant (Section 1A-A; 
PIRPLH.PHCON) in the Pool History record is zero. 

 
 

 Principal = Principal amount of securities from last report (Section 3-A in 
Pool History; PIRPLH.PHPAS) 

 P&I Constant = Interest being passed thru on Pool; Cash distribution due 
holders for interest (Section 2-F in Pool History) 

 Interest Rate = Pass Thru Rate (net interest rate) 

 Interest Compounding Frequency = M 

 Service Fee % = .00 since pass thru rate has been entered instead of 
gross rate 

 First Payment Date = 1st of the month after the Reporting Period (i.e. MDF 
for Reporting Month of 4/2013 would have “5/01/2013” as First Payment 
Date) 

 Maturity Date = Effective Date of Prepayment record where Type = “PAR” 

 Interest Basis = A60 

 Print Service Fee Information = No 
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Retrieve the Total Interest amount from the bottom of the amortization schedule: 
 

 
 
MDF Amount = $17,888.06 / $2,128,679.14 = .008403 
 
PRINCIPAL & INTEREST:  This is the calculation that will be run for any 
pool (construction or permanent) where the Constant (Section 1A-A; 
PIRPLH.PHCON) in the Pool History record is NOT equal to zero. 
 

 

 Principal = Principal amount of securities from last report (Section 3-A in 
Pool History; PIRPLH.PHPAS) 

 P&I Constant = Constant (Section 1A-A in Pool History; PIRPLH.PHCON) 

 Interest Rate = Note Rate (gross interest rate) 

 Interest Compounding Frequency = M 
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 Service Fee % = Servicing fee rate (PIRPL.PLSERV) + Guaranty fee rate 
(PIRPL.PLGFEE) 

 First Payment Date = 1st of the month after the Reporting Period (i.e. MDF 
for Reporting Month of 4/2013 would have “5/01/2013” as First Payment 
Date) 

 Maturity Date = Effective Date of Prepayment record where Type = “PAR” 

 Interest Basis = A60 

 Print Service Fee Information = Yes 
 

Go to the bottom of the schedule and retrieve the last two amounts for Total 
Principal and Net Pymt To Inv: 
 

 

 
 
Subtract the “Total Principal” from the “Net Pymt to Inv” to get the total pass thru 
interest = $880,982.67.   
 
Retrieve the Net Interest (pass thru amount) from Section 2-F in Pool History = 
$8,911.93. 
 
MDF Amount = $8,911.93 / $880,982.67= .01011589 
 


